
 To determine if your e-mail has been read

1 Sign on to America Online.

2 On the Mail Center menu, click Sent Mail.

3 Click once on a piece of e-mail to select it.

4 Click Status.

Notes

· You can only check the status of e-mail sent to other American Online members.    AOL cannot report the status 
of e-mail sent to an Internet address. The status not applicable will appear for e-mail sent to an Internet 
address.

· You can request a return receipt for e-mail sent to other AOL members.

             Related Topics   –   E-mail  



 To request a return receipt

1 Click Write.

2 Address your e-mail as usual.

3 Select the Request “Return Receipt” from AOL members check box.

4 Type your message and send your e-mail as usual.

Notes

· You will receive an e-mail notification when each AOL member opens your e-mail.

· You will not receive a return receipt for e-mail you send to Internet addresses. 

             Related Topics   –   E-mail  



 How long does e-mail stay in the online mailbox?

You can set a mail preference to keep e-mail in your online mailbox for up to 3 days after it has been opened.    If you 
have not opened your new e-mail within approximately 27 days, it is deleted.

             Related Topics   –   E-mail  



  How do I know I have e-mail?

If you have e-mail waiting for you when you sign on to America Online, the flag on the mailbox on the “Welcome 
screen” will be up.    If your computer has a sound card, you will also hear “You’ve got mail.”

             Related Topics   –   E-mail  



 To read e-mail in your online mailbox

1 Sign on to America Online.

2 Click Read.

3 Double-click the first e-mail item to read it.

Notes

· You can set a mail preference to keep e-mail in your online mailbox for up to 7 days after it has been opened. 

· The more you use    e-mail, the more you may want to use Automatic AOL to manage your e-mail. 

             Related Topics   –   E-mail  



 What's the difference between the online mailbox and the offline mailbox?
E-mail in your online mailbox (the Read Mail, Old Mail, and Sent Mail selections on the Mail Center menu) is 
stored on the America Online host computer and is only available while you are signed on to America Online. 
E-mail in your offline mailbox (the Read Offline Mail selection on the Mail Center menu) is part of your Personal 
Filing Cabinet and is available whether you are online or not.    It is stored on your computer and will remain there until 
you delete it. 

             Related Topics   –   E-mail  



  To reach an outside line

1 On the Sign On screen, click Setup.

2 On the AOL Setup screen, click Expert Setup.

3 On the Locations tab in the Connection Setup window, click the number (connection) you want to edit once to 
select it. (The number (connection) is indented beneath the location name.)

4 Click Edit.

5 In the Edit Number (Connection) window, select the Dial [9,    ] to reach an outside line check box.

6 Edit the default prefix if it is not correct, and make sure there is a comma after it.

Notes

· You will have to edit each number in the location and make this change.

             Related Topics   –   Setup  



  To use pulse dialing

1 On the Sign On screen, click Setup.

2 On the AOL Setup screen, click Expert Setup.

3 On the Locations tab in the Connection Setup window, click the number (connection) you want to edit once to 
select it. (The number (connection) is indented beneath the location name.)

4 Click Edit.

5 In the Edit Number (Connection) window, select the I do not have touch tone service check box.

Notes

· You will have to edit each number in the location and make this change.

             Related Topics   –   Setup  



  To turn off call waiting while you are online

1 On the Sign On screen, click Setup.

2 On the AOL Setup screen, click Expert Setup.

3 On the Locations tab in the Connection Setup window, click the number (connection) you want to edit once to 
select it.    (The number (connection) is indented beneath the location name.)

4 Click Edit.

5 In the Edit Number (Connection) window, select the Dial [*70,]    to disable call waiting check box.

6 Edit the default prefix if it is not correct, and make sure there is a comma after it.

More information about this topic 

Notes

· You will have to edit each number in the location and make this change.
             Related Topics   –   Setup  



More information about disabling Call Waiting

· Typical codes are *70 for Touch-Tone service and 1170 for rotary service.    Contact your local telephone 
company for the deactivation code in your area.

· When you sign off and your modem hangs up the phone, Call Waiting is reactivated.

· If you do not turn off Call Waiting while you are connected to America Online, you will lose your connection if you 
receive an incoming call. 



  About AOL access phone numbers

The AOL access phone number is the telephone number your modem dials to connect to America Online.

You will incur phone charges if you select an AOL access phone number that is a long distance call for you, or is not 
covered by your local calling plan. Please check with your local phone company for more information.

             Related Topics   –   Setup  
             Related Topics   –   Access Numbers  



 To set up a TCP/IP location

1 On the Sign On screen, click Setup.

2 On the AOL Setup screen, select the Create a location for use with new access phone numbers or an ISP 
option and click Next. 

3 In the Add Location window, type a name for the location (for example, TCP/IP location).

4 Select Add a custom connection (for example TCP/IP) and click Next. A TCP/IP location will be created.

             Related Topics   –   Setup  
             Related Topics   –   TCP/IP  



  To connect to AOL via TCP/IP

1 Establish your LAN connection, if necessary. 

2 Start America Online.

3 On the Sign On screen, select your TCP/IP location from the Select Location list.

4 Sign on to America Online.

             Related Topics   –   Setup  
             Related Topics   –   TCP/IP  



 About TCP/IP

TCP/IP is a communications format for transferring data on a local area network (LAN).    You can use TCP/IP (if it is 
available on your computer) instead of your modem to connect to America Online at no extra charge.    Connecting to 
America Online with TCP/IP is often faster than the usual modem-based connection process, and it will not interfere 
with your use of other TCP/IP applications like Netscape(c). 

If you have a LAN, ask your system administrator if you have TCP/IP capabilities. 

You may also be able to obtain a modem-based TCP/IP connection (called either a SLIP or a PPP connection) from a 
local Internet Service Provider (ISP). 

             Related Topics   –   Setup  
             Related Topics   –   TCP/IP  



 Telephone Support

· For technical support, call 1-888-265-8006 or 1-703-264-1184 (outside the U.S. and Canada).

· For sales, billing and other account inquiries, call 1-800-827-6364.

· Our TTY number is 1-800-759-3323 (within the U.S. and Canada).

America Online receives a large number of phone calls for technical assistance. Often you can get help faster in other 
ways. 



    Modem Installation Checklist

If you have an external modem:

1 Make sure the modem's power cord is securely plugged in and that the modem is turned on. If the modem has 
power, then its LED lights or LCD display should be on.

2 Make sure the modem cable is securely attached to the modem and to the computer.

If you have an internal modem:

1 Quit all software programs that are running.

2 Click Start on the Windows taskbar and select Shut Down. 

3 Select the option to shut down your computer and click OK (or Yes.) 

4 If your computer does not turn off automatically, wait until you see the message that it is safe to do so, and turn off 
your computer.

5 Wait 10–15 seconds.

6 Restart your computer.

For all modems:

1 Make sure the phone line coming from the wall is plugged into the modem connection that reads PHONE LINE, 
JACK, or TO WALL.

2 Unplug the line going into the modem and connect it to a phone; listen for a normal dial tone.

3 Check to see if an extension is off the hook.

4 Quit any other communications software (for example, fax software) that is using the modem.

Notes

· If you subscribe to a home-based voice-mail service offered by many telephone companies, the special tones 
used to identify the existence of a message can interfere with the normal operation of your modem.    Check for 
this interference by listening for a normal dial tone from your telephone receiver.

· If you have a Meridian, Aspect, Rolm, or other digital phone system (normally used only in office buildings), then 
your phone system probably is not compatible with your modem (standard modems send analog signals).

Is there a dial tone?

 Yes, there is a dial tone.
 No, there is no dial tone.



Your modem may be defective

Contact your modem manufacturer for more help.



Problem with the phone line

The problem most likely lies in your phone line.    Contact your local phone company for help.



Problem in the final connection step

There is a temporary problem somewhere in the network that is preventing the connection from completing.

Try to connect again later, or try using another AOL access phone number.



 Is there anything unusual about your phone line?
             I have Call Waiting.  
             I have to dial a prefix to reach an outside line.  
             No, it's an ordinary phone line.  



  To verify that your dialing options are set to turn off Call Waiting

1 On the Sign On screen, click Setup. 

2 On the AOL Setup screen, click Expert Setup.

3 On the Locations tab in the Connection Setup window, click the number (connection) you want to edit once to 
select it. (The number (connection) is indented beneath the location name.)

4 Click Edit.

5 In the Edit Number (Connection) window, select the Dial [*70,    ]    disable call waiting check box.

6 Edit the default prefix if it is not correct, and make sure there is a comma after it.

More information about this topic

Notes

· You will have to edit each number in the location and make this change.

             Other places to get help   



 To verify that dialing options are set for an ordinary phone line

1 On the Sign On screen, click Setup.

2 On the AOL Setup screen, click Expert Setup.

3 On the Locations tab in the Connection Setup window, click the number (connection) you want to edit once to 
select it. (The number (connection) is indented beneath the location name.)

4 Click Edit.

5 In the Edit Number (Connection) window, clear the Dial [*70,    ]    to disable call waiting check box.

6 Clear the Dial [9, ] to reach an outside line check box.

Notes

· You will have to edit each number in the location and make this change.

             Other places to get help   



 To verify that dialing options are set to dial an outside line

1 On the Sign On screen, click Setup.

2 On the AOL Setup screen, click Expert Setup.

3 On the Locations tab in the Connection Setup window, click the number (connection) you want to edit once to 
select it. The number (connection) is indented beneath the location name.

4 Click Edit.

5 In the Edit Number (Connection) window, clear the Dial [*70,    ]    to disable call waiting check box.

6 Select the Dial [9,    ] to reach an outside line check box.

7 Edit the default prefix if it is not correct, and make sure there is a comma after it.

Notes

· You will have to edit each number in the location and make this change.

             Other places to get help   



 Try using a new location file

1 On the Sign On screen, click Setup.

2 On the AOL Setup screen, select Create a location for use with new access phone numbers or an ISP and 
click Next.

3 In the Add Location window, type a name for the new location (for example, San Francisco numbers).

4 Select Add numbers from a list of access phone numbers and click Next.

5 Type the area code you want to connect from and click Next.

6 In the Select Access Numbers window, click an access number    from the list on the left once to select it.

7 Click Add.

8 Verify the information in the Add AOL Access Phone Number window, and click OK.

9 Repeat steps 6-8 until you have added as many access phone numbers to this location as you want, then click 
Next.

10 On the Sign On screen, select the location you just created from the Select Location: list and click Sign On.

Did this fix the problem?
             Yes.  
             No, I still need more help.  



 Use Auto Detect to identify your connection devices

1 On the Sign On screen, click Setup

2 On the AOL Setup screen, click Expert Setup.

3 On the Connection Setup window, click the Devices (modems, etc.) tab.

4 Click Auto Detect. 

5 When the connection devices on your computer have been detected, select the one you want to use to connect 
and click Next.

             This didn  ’  t fix the problem.  
             Auto Detect couldn  ’  t detect my modem.   



 To configure your modem manually

1 On the Sign On screen, click Setup.

2 On the AOL Setup screen, click Expert Setup.

3 On the Connection Setup window, click the Devices (modems, etc.) tab.

4 Click Expert Add.

5 Select Modem (telephone line connection) from the list, then click Next.

6 Select your modem from the Modem: list, the COM port your modem is using from the Connected to port: list, 
and the highest rate at which your modem can transmit data (not fax) from the Port speed: list.

7 Click OK.

Notes

· The AOL software can detect most modems automatically. In most instances you will not need to configure the 
modem yourself.

             Related Topics   –   Setup  
             Related Topics   –   Modems  



     America Online was unable to open the communications port

This error message appears when your modem is already in use by another program, such as fax software or 
another communications program.

1 Quit the other program.

2 Try to connect to America Online again.

3 Check that the correct modem is selected.

             Other places to get help   



    Problem with the access number

· If the problem is sporadic, try again later, or try using another access number.

· If you have the problem no matter what access number you use, verify the modem that is selected in your setup.

· If you subscribe to a voice-mail service, determine if voice messages are interfering with your connection.

· If you have call waiting, turn off call waiting when you connect.

· If you are dialing from an office, determine if you must dial a prefix to get an outside line. 

Note
You will incur phone charges if you select an AOL access phone number that is a long distance call for you, or is not 
covered by your local calling plan. Please check with your local phone company for more information.

If you consistently have problems with a particular access number, then please report the problem to technical 
support. 



 To set up your computer to connect to America Online
             Using Auto Detect to find your modem or other connection device   
             Adding modem locations   
             Adding access phone numbers to locations   
             Adding a TCP/IP location   
             Adding a DSL location   
             Adding a cable modem location   
             Using Expert Setup   
             Related Topics   –   Setup  



  About Member Services

Member Services is an area of America Online filled with helpful information about using the service and technical 
assistance for problems you may be having.    If you have an hourly billing plan, the time you spend in this unlimited 
use area is not counted as part of your connect time on America Online. (Telephone surcharges, if applicable, will still 
apply.) 

Notes

· Go to Keyword: Billing for information about your account, or for more information about the other pricing plans 
that are available.

· If you have an hourly billing plan the time spent in the unlimited use area is calculated and subtracted from your 
connect time when you sign off.

· For the latest surcharge information, go to Keyword: Access.

             Other places to get help   



  To get billing information

1 Sign on to America Online.

2 Go to Keyword: Billing.

Notes

· You can view your present month’s bill, change your price plan, or update your address, billing information, or 
billing method.

             Important information about your password  



 Telephone surcharges

Telephone surcharges apply in the following instances:

· If you sign on with an access number that is outside the United States or Canada.

· If your access phone number is a long-distance call, or

· If you use the United States AOLnet 800 or 888 number (1-800-716-0023 or 1-888-245-0113) or the Canadian 
AOLnet 800 number (1-800-318-2265) as your access number. 

These surcharges vary and are subject to change.    You can find the latest surcharge information online at Keyword: 
Access.

             Using TCP/IP to connect  



  To add an access phone number to a location

1 On the Sign On screen, click Access Numbers.

2 In the Search for AOL Access Numbers window, type the area code you want to connect from and click Next.

3 In the Select AOL Access Numbers window, select the location to which you want to add access numbers from 
the Add numbers to this Location list. 

4 From the AOL access phone numbers list on the left click an access number once to select it and click Add. 

5 If the phone number and modem information are correct in the Add AOL Access Phone Number window, click 
Next. Otherwise, click Edit to correct the information. 

6 Repeat steps 4-5 until you have added as many access phone numbers to this location as you want and then 
click Next. The Sign On screen will appear.

7 Click Sign On.

Notes

· You will incur phone charges if you select an AOL access phone number that is a long distance call for you, or is 
not covered by your local calling plan. Please check with your local phone company for more information.

             Related Topics   –   Setup  
             Related Topics   –   Access Numbers  



 AOLnet 800 number access

If there is no access phone number in your area, you can connect to America Online from anywhere in the United 
States at speeds up to 28,800 bps by using surcharged access numbers.    Your America Online account will be 
charged an extra fee for the entire time you are connected using this number, even during your free trial period.    
This extra fee is subject to change.    For the latest surcharge information, sign on to AOL and go to Keyword: 
Access.

             Related Topics   –   Setup  
             Related Topics   –   Access Numbers  



  To set up a location that uses the surcharged access numbers

1 On the Sign On screen, click Setup.

2 On the AOL Setup screen, click Create a location for use with new access phone numbers or an ISP and 
then click Next.

3 In the Add Location window, type a name for the new location (for example, Surcharged numbers).

4 Select the number of times you want your modem to try connecting to the surcharged location (for example, if the 
number is busy).

5 Click Add numbers from the list of access phone numbers, and click Next. (Move this help window if it is in 
the way.)

6 In the Search for AOL Access Numbers window, type 800 or 888 as the area code you want to connect from and 
click Next.

7 In the Select AOL Access Numbers window, select the location to which you want to add access numbers from 
the Add numbers to this Location list.

8 From the AOL access phone numbers list at left, click an access number once to select it.

9 Click Add. 

10 If the phone number and modem information are correct in the Add AOL Access Phone Number window, click 
Next. Otherwise, click Edit to correct the information.

11 Repeat steps 8-10 until you have added as many surcharged access phone numbers to this location as you want 
and click Next. The Sign On screen will appear.

12 Click Sign On.

             Related Topics   –   Setup  
             Related Topics   –   Access Numbers  



 To use the Keyword function

1 Sign on to America Online. 

2 Type the Keyword for the area you want to go to into the text entry box on the toolbar.

3 Press Enter.

Notes

· You can use the Keyword function to go to a site on the Internet.    Just type the Web address (for example:    
http://www.aol.com) as the Keyword.



  To report a problem with an access number

If you are able to get online, report the problem at Keyword: Access.

If there is no other access number for you to use, and you are unable to get online, you can report the problem by 
calling our Technical Support number.



  To get help online

On the Help menu, click  Member Services Online Help, (or go to Keyword: Help) to get technical information, 
information on how to contact America Online Technical Support, as well as answers to frequently asked questions 
about using the service.

If you have an hourly billing plan: The time spent in the Member Services area is calculated and subtracted from 
your connect time when you sign off.    (Telephone surcharges, if applicable, will still apply.)

             Related Topics   –   Getting Help  



  To create a custom modem command 

1 Click here  to print this information.

2 Use the table below to help you create a modem command.    The table below shows the most common 
parameters, settings, and commands.    See your modem manual to verify the commands to use for your modem.

3       Edit the modem commands   in the setup.

Parameter Setting Usual Command

Data Compression On %C1
Error Correction On &Q5
Flow Control Hardware – Request to Send/

Clear to Send (RTS/CTS)
&K3

Local Echo On E1
Verbose Responses Word responses V1
Extended Result Codes Respond to dial tone and busy signal X1 or X4 (preferably X4)
DCD Track the state of data carrier from 

the remote modem
&C1

Important!

· Your modem string should begin with the AT&F commands, and end with ^M (a carriage return).

· Use all capital letters and the number 0, not the letter O.

             Related Topics   –   Setup  
             Related Topics   –   Modems  



  To edit the modem commands

1 On the Sign On screen, click Setup.

2 On the AOL Setup screen, click Expert Setup.

3 On the Connection Setup window, click the Devices (modems, etc.) tab. 

4 Click the Modem: connection, if it is not already selected.

5 Click Edit.

6 In the Expert Edit (or Add) Modem window, click Edit Commands..

7 Type your custom modem commands in the Setup Modem String box.

8 Click OK.

             Using Auto Detect to configure your modem setup   
             Other places to get help   



     About locations and numbers (connections)

Locations

A location contains one or more numbers (connections) that contain a common element (for example, several 
numbers that will connect you from a certain city).    If you have America Online on your laptop computer, you can 
create separate locations for use at home, at your office, or in the cities you travel to frequently. 

Numbers (Connections) 

A number (connection) is the information your computer needs to connect to America Online — such as what type of 
modem you have (or whether you use TCP/IP, a DSL line, or a cable modem to connect) and what access phone 
numbers to use to connect. 

             Related Topics   –   Setup  



 To add a new location

1 On the Sign On screen, click Setup.

2 On the AOL Setup screen, click Create a location for use with new access phone numbers or an ISP and 
then click Next.

3 In the Add Location window, type a name for the new location (for example, San Francisco numbers). (Move this 
help window if it is in the way.)

4 Select the number of times you want your modem to try connecting to the location (for example, if the number is 
busy).

5 Click Add numbers from the list of access phone numbers and click Next.

6 In the Search for AOL Access Numbers window, type the area code you want to connect from and click Next.

7 In the Select AOL Access Phone Numbers window, click an access number from the list on the left once to 
select it.

8 Click Add.

9 If the phone number and modem information are correct in the Add AOL Access Phone Number window, click 
Next. Otherwise, click Edit to correct the information.

8 Repeat steps 7-9 until you have added as many access phone numbers to this location as you want and click 
Next. The Sign On screen will appear.

9 Click Sign On.

Notes

· You will incur phone charges if you select an AOL access phone number that is a long distance call for you, or is 
not covered by your local calling plan. Please check with your local phone company for more information.

             Related Topics   –   Setup  
             Related Topics   –   Access Numbers  



How do I move the Help window?

1 Click the title bar (the colored area across the top of the window with the words America Online Help) and hold 
the left mouse button down.

2 Drag the window to a new location.

3 Release the left mouse button.



  To have your screen name(s) appear on the Sign On screen

1 On the Sign On screen, select Existing Member from the Select Screen Name list.

2 Click Sign On.

3 Enter a screen name from your account and the password for that screen name when prompted.    The next time 
you sign on, all of your screen names will appear on the Sign On screen.

Why did this happen?



 Why did this happen?

If you reinstalled the software on your current computer or installed the software for the first time on a new computer, 
your screen names will not be available on the Sign On screen until you sign on for the first time using that software.



 Your account is already signed on

This error message will appear under two circumstances:

· Another screen name on your account is signed on from another computer.    Although you can have up to seven 
screen names on your account, only one screen name can be online at a time.

· Your America Online session ended abnormally, and it might take the America Online host computer 5-10 
minutes to realize you are no longer connected.    In this case, just wait a few minutes and try again.

             Related Topics   –   Errors  



  About the Download Manager

The Download Manager allows you to download all of your stored files at the end of your AOL session. You can also 
schedule Automatic AOL to download the files at a later time.    It also allows you to find files you have already 
downloaded. Whenever you find a file that you want to save to your hard drive, whether it’s attached to an e-mail 
message or is in an AOL file library online, click Download Later (instead of the Download Now). This stores the file 
in your Download Manager. 

WARNING! 

             Related Topics   –   Downloading  



  To send e-mail to more than one person

1 Click Write.

2 In the Send To: box, separate the e-mail addresses of the recipients with a comma. 

For example:    AOLMember1, AOLMember2, AOLMember3

             Related Topics   –   E-mail  
             Related Topics   –   Address Book  



  To send a blind carbon copy

1 Click Write.

2 In the Send To: (or Copy To:) box, enclose the e-mail address(es) of the recipient(s) of the blind carbon copy in 
parentheses. 

For example:    (AOLMember1, AOLMember2)

More information about this topic

             Related Topics   –   E-mail  



More information about blind carbon copies

· You can combine regular recipients and blind carbon copy recipients on the same list. 

For example:    AOLMember1, (AOLMember2) 

In this example, AOLMember2 will see that the e-mail was addressed to AOLMember1, but AOLMember1 will not 
know that AOLMember2 received a blind carbon copy.

· Recipients of blind carbon copies will not see the names of any other recipients of blind carbon copies. 

For example:    (AOLMember1, AOLMember2, AOLMember3) 

In this example, AOLMember1, AOLMember2,    and AOLMember3 will each see their name on the e-mail they 
receive, but not the names of the other two recipients.

· As the sender of the e-mail, you will always see all names on the e-mail (even those who received blind carbon 
copies) — whether you look in your online mailbox, or your offline mailbox, or if one of the e-mail recipients 
forwards a copy of the e-mail back to you.



  To mark a file for the Download Manager to download

1 Sign on to America Online.

2 Locate a file online that you want to download.

3 Click Download Later.

             Related Topics   –   Downloading  



  To download the files in the Download Manager

1 Sign on to America Online. 

2 On the My Files menu, click Download Manager.

3 Click Start Download.

             Related Topics   –   Downloading  



  To change the Download Manager preferences

1 On the My Files menu, click Download Manager.

2 Click Download Preferences.

             Related Topics   –   Downloading  
             Related Topics   –   Preferences  



  To change the destination for downloaded files

1 On the My Files menu, click Download Manager.

2 Click Select Destination.

3 In the Select Path window, navigate to, and double-click the folder on your computer where you want to save the 
files you download.    (Move this help window if it is in the way.)

4 Click OK.

More information about this topic 

             Related Topics   –   Downloading  
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More information about the destination for downloaded files

If you click Download Now when you download a file, you will be prompted to select the folder where you want to 
save the file on your computer.



  To locate a file after you download it

1 On the My Files menu, click Download Manager.

2 Click Show Files Downloaded.

3 Select the file you want to locate on your computer.

4 Click Locate to access the file. 

More information about this topic 

             Related Topics   –   Downloading  



More information about downloaded files

All files you download are placed in the default download destination folder (America Online 5.0\DOWNLOAD) or 
another folder that you selected to be the download destination folder.



  To create a mailing list

1 On the Mail Center menu, click Address Book.

2 Click New Group.

3 In the Group Name box, type the name you will use to refer to this mailing list. 

For example:    My online friends

4 In the Addresses box, type the screen names and/or Internet e-mail addresses of the people you want to include 
on this mailing list, separating each name with a comma. 

For example:    AOLMember1, name@companyname.com, AOLMember2

             Related Topics   –   E-mail  
             Related Topics   –   Address Book  



  To add a picture to your address book

1 On the Mail Center menu, click Address Book.

2 Select an existing entry and click Edit Person (or add a new name). 

3 Click the Picture tab.

4 Click Select Picture.

5 Navigate to the folder that contains the picture you want to add, and double-click the image file name.

More information about this topic 

             Related Topics   –   E-mail  
             Related Topics   –   Address Book  



More information about images

The following image file formats are supported:

.art ,.jpg, .gif, .bmp



More information about Instant MessageÒ notes

· You can use the Instant Message feature to send a message to someone who is signed on at the same time you 
are.

· You can click Available? before you send your message to determine if the person is currently signed on.



More information about your member profile

· Your screen name is not listed in the searchable Member Directory until you create a member profile.

· You can add as much or as little personal information as you want to your member profile.



 To add a name to your address book

1 On the Mail Center menu, click Address Book.

2 Click New Person.

3 In the First Name and Last Name boxes, type the person’s name. 

4 In the E-mail Address box, type the person's screen name or Internet e-mail address. 

For example:    AOLMember1

             Related Topics   –   E-mail  
             Related Topics   –   Address Book  



  To change your password

1 Sign on to America Online.

2 Go to Keyword: Password.

Notes

· Anyone who knows your password and screen name can sign on to your account.    No one from America Online 
will ever ask you for your password (or your credit card number). You should never reveal your password to 
anyone.

· You should change your password frequently.

             Related Topics   –   Online Security  



 To send e-mail to an Internet address

1 Click Write.

2 In the Send To: box, type the Internet address of the recipient of your e-mail. 

For example:    name@companyname.com

             Related Topics   –   E-mail  



 What’s my e-mail address?

· Your e-mail address for correspondence with other members of America Online is your screen name. 

For example: AOLMember1

· Your e-mail address for correspondence from outside of America Online (such as through the Internet or another 
online service) is your screen name (without any capitalization or spaces) followed by @aol.com 

 For example:    aolmember1@aol.com

             Related Topics   –   E-mail  



  To sign on from a friend's computer

1 On the Sign On screen, select Guest from the Select Screen Name list.

2 Click Sign On.

3 Enter a screen name and password from your account when prompted.

More information about this topic



More information about the Guest function

· The time you spend online as a Guest is charged to your account.

· You cannot access your address book, Personal Filing Cabinet, or your Favorite Places when signed on as a 
Guest from another computer (because this information resides on your own computer). 

· You cannot use Automatic AOL or the Download Manager when you are signed on as a Guest.



 About Automatic AOL 

You can use the Automatic AOL function to perform tasks for one or more screen names on your account 
automatically.    You can:

· send and retrieve e-mail.

· send and retrieve newsgroup or message board messages.

· download files you have collected in your Download Manager. 

You can run Automatic AOL on demand, or set up a schedule and have the tasks performed at certain times of the 
day whether you’re at your computer or not.

More information about this topic 

             Related Topics   –   Automatic AOL  



More information about Automatic AOL

· Each screen name has its own incoming mailbox, outgoing mailbox, and Download Manager.

· You cannot use Automatic AOL if you signed on as a Guest.

· Automatic AOL settings (schedules, actions to be performed, etc.), apply to all screen names.



 To set tasks and screen names for Automatic AOL 

1 On the My AOL menu, click Preferences.

2 In the Preferences window, click Auto AOL.

3 Select the tasks you want Automatic AOL to perform (for example: Send mail    . . .    or Get unread mail . . .).

4 Click Select Names.

5 Select the screen names and type passwords to be used sign on. (Move this help window if it is in the way.)

Notes

· Anyone who has physical access to your computer can sign on to your account if you store your password. 

· If you decide not to store your passwords, you can sign on to America Online with each screen name and start 
Automatic AOL manually while you are online.

             Related Topics   –   Automatic AOL  
             Related Topics   –   Preferences  



 About the Web browser
The Web browser is a built-in feature of the AOL software that allows you to access and view information located on 
the World Wide Web.

When you use America Online or want to access the World Wide Web, the Web browser is the tool that displays Web 
pages and helps you to navigate from one site to another. 

AOL’s Web browser controls are located on the Navigation bar — the area right below the colorful toolbar icons.

To learn more about the Web browser:

1 Sign on to America Online.

2 Go to Keyword: Help.

3 Select Internet & World Wide Web from the topic menu.

4 Click World Wide Web.

5 Look for the article about the Web browser.



  To set up Automatic AOL to send and retrieve e-mail

1 On the My AOL menu, click Preferences.

2 In the Preferences window, click Auto AOL.

3 Select the Send mail . . . check box. (Move this help window if it is in the way.)

4 Select the Get unread mail . . . check box.

5 Click Select Names and select the screen names and passwords for Automatic AOL to use.

Notes

· Anyone who has physical access to your computer can sign on to your account if you store your password. 

· If you decide not to store your passwords, you can sign on to America Online with each screen name and start 
Automatic AOL manually while you are online.

             Related Topics   –   Automatic AOL  
             Related Topics   –   E-mail  



  To send e-mail you have written offline

1 On the My AOL menu, click Preferences.

2 In the Preferences window, click Auto AOL.

3 Select the Send mail . . . check box.

4 Click Select Names and select the screen names and passwords for Automatic AOL.

5 Click Activate Automatic AOL Now.

Notes

· If you are online when you activate Automatic AOL, it will run only for the screen name you are signed on with.

· If you want to activate Automatic AOL for all the screen names you selected when you set up Automatic AOL, 
sign off before you activate Automatic AOL.

             Related Topics   –   Automatic AOL  
             Related Topics   –   E-mails  



  To download files with Automatic AOL

1 If you have not already done so, select the files you want to download.

2 On the    My AOL menu, click Preferences.

3 In the Preferences window, click Auto AOL.

4 Select the Download selected files check box. 

5 Click Select Names and select the screen names and passwords for Automatic AOL to use.

6 Click Activate Automatic AOL Now.

Notes

· If you are online when you activate Automatic AOL, it will run only for the screen name you are signed on with.

· If you want to activate Automatic AOL for all the screen names you selected when you set up Automatic AOL, 
sign off before you activate Automatic AOL.

             Related Topics   –   Automatic AOL  
             Related Topics   –   Downloading  



  To set up Automatic AOL to send and retrieve message board and Internet newsgroup messages

1 On the My AOL menu, click Preferences.

2 In the Preferences window, click Auto AOL.

3 Select the Send postings . . . check box. (Move this help window if it is in the way.)

4 Select the Get unread postings . . . check box.

5 Click Select Names and select the screen names and passwords for Automatic AOL.

Notes

· Anyone who has physical access to your computer can sign on to your account if you store your password. 

· If you decide not to store your passwords, you can sign on to America Online with each screen name and start 
Automatic AOL manually while you are online.

             Go back to overview  



 To select newsgroups to read offline

1 Sign on to America Online. 

2 Go to Keyword: Newsgroups.

3 Click Read Offline. 

4 Select newsgroups from your Subscribed Newsgroups to add as Newsgroups to Read Offline.

             Go back to overview   



    To activate Automatic AOL 

1 On the Mail Center menu, click Run Automatic AOL Now.

2 Click Begin.

Notes

· If you are online when you activate Automatic AOL, it will run only for the screen name you are signed on with.

· If you want to activate Automatic AOL for all the screen names you selected when you set up Automatic AOL, 
sign off before you activate Automatic AOL.

             Go back to overview  



    To activate Automatic AOL 

1 On the Mail Center menu, click Run Automatic AOL Now.

2 Click Begin.

Notes

· If you are online when you activate Automatic AOL, it will run only for the screen name you are signed on with.

· If you want to activate Automatic AOL for all the screen names you selected when you set up Automatic AOL, 
sign off before you activate Automatic AOL.

             Related Topics   –   Automatic AOL  



 To schedule Automatic AOL to run later

1 On the My AOL menu, click Preferences.

2 In the Preferences window, click Auto AOL.

3       Select tasks and screen names   for Automatic AOL.

4 Click Schedule Automatic AOL.

5 Select the Enable Scheduler check box.

6 Select the days and times you want Automatic AOL to run.

7 Make sure the America Online application is open (not signed on) at the scheduled time.

Notes

· If you are online when you activate Automatic AOL, it will run only for the screen name you are signed on with.

· If you want to activate Automatic AOL for all the screen names you selected when you set up Automatic AOL, 
sign off before you activate Automatic AOL.

             Related Topics   –   Automatic AOL  



 To read and respond to message boards or Internet newsgroup messages offline

1 On the My Files menu, click Personal Filing Cabinet.

2 In the Newsgroups folder, double-click the message you want to read.

3 Highlight a section of text to select it, if you want to quote it in your response.

4 Click Reply to Group to send a response to the message board or newsgroup (or Reply to Author if you want to 
send a private e-mail as a response).    If you click Reply to Author 

5 Compose your response to the quoted material and click Send Later.

More information about this topic

             Using automatic quoting in your responses  
             Go back to overview  



  To read e-mail retrieved by Automatic AOL 

1 On the Mail Center menu, point to Read Offline Mail then click Incoming/Saved Mail.

2 Double-click the e-mail item you want to read.

             Related Topics   –   Automatic AOL  
             Related Topics   –   E-mail  



  To read and respond to your e-mail offline 

1 On the Mail Center, point to Read Offline Mail, then click Incoming/Saved Mail.

2 Double-click the e-mail item you want to read.

3 Highlight a section of text to select it, if you want to quote it in your response.

4 Click Reply (or Forward).

5 Add your response to the quoted material.

6 Click Send Later.

             Go back to overview  



  To use automatic quoting in e-mail responses

1 Open the e-mail message you want to respond to.

2 Highlight the section of text you want to quote to select it.

3 Click Reply (or Forward).

4 Add your response to the quoted material.

More information about this topic

             Selecting the quoting style you want to use  
             Related Topics   –   E-mail  



More information about automatic quoting

· America Online style quoting places two quoting marks at the beginning and end of the quoted section.

<<This is an example of the America Online style of quoting.>>

· Internet style quoting places one quote mark at the beginning of each line of the quoted section.

>This is an example of the

> Internet style of quoting.



  To use automatic quoting for newsgroup responses

1 On the My Files menu, click Personal Filing Cabinet.

2 In the Newsgroups folder, double-click the newsgroup message you want to respond to.

3 Highlight the section of text you want to quote to select it.

4 Click Reply (or Reply to Author).

5 Add your response to the quoted material.

More information about this topic

             Retrieving message board posts   



More information about automatic quoting in newsgroup replies

The ability to use automatic quoting in replies to newsgroup messages is only available on messages retrieved by 
Automatic AOL and responded to from the Personal Filing Cabinet.



  To select the quoting style for e-mail responses

1 On the My AOL menu, click Preferences.

2 In the Preferences window, click Mail.

3 Select (or clear) the Use AOL style quoting in mail check box.

More information about this topic

             Using automatic quoting in e-mail responses  



 To start the Web browser

1 Sign on to America Online. 

2 On the Internet menu, click Go to the Web.

             Related Topics   –   Browser  



 To go directly to a Web site

1 Sign on to America Online. 

2 Type the URL directly into the text entry box on the toolbar and press Enter.

             Related Topics   –   Browser  



What's an URL?

The URL, or Uniform Resource Locator, is a path for locating sites on the World Wide Web.    For example, 
http://www.aol.com is the URL for the America Online Home Page. 



  To set Web browser preferences

1 On the My AOL menu, click Preferences.

2 In the Preferences window, click    W W W.

             Related Topics   –   Browser  
             Related Topics   –   Preferences  



  About your password

Anyone who knows your screen name and password can use your account.    America Online employees will never 
ask for your password (or credit card number).    Your password should be easy for you to remember, but difficult for 
others to guess.    As an extra precaution, you should change it often (at Keyword: Password).      The most secure 
passwords are combinations of letters and numbers.

NEVER REVEAL YOUR PASSWORD TO ANYONE

             Related Topics   –   Online Security  



  About Parental Controls

Parental Controls enable the primary master account holder (the screen name that was created during your first sign-
on to America Online) to restrict access to certain areas and features on America Online for one or all of the screen 
names on the account.

Once Parental Controls have been set for a particular screen name, they are active each time that screen name signs 
on. The master account holder can make changes to these controls at any time. The master account holder may also 
designate Master Screen Name status for up to 2 additional existing or newly created screen names besides the 
primary screen name.

Sign on to AOL and go to Keyword: Parental Controls to familiarize yourself with the controls that are available to 
help you make your child's online experience a safe and positive one.

More information about this topic 
             Related Topics   –   Online Security  



  About screen names

Each AOL account can have up to seven screen names at any one time. The screen name you chose when you set 
up your AOL account is your Master screen name; it cannot be deleted or changed. 

Keep in mind the following:

· Your screen name is your AOL e-mail address.

· Your screen name can be seen in public places, such as chat rooms, message boards, Hometown AOL, and the 
AOL Member Directory (if you have created a Member Profile). If you want, you can take steps to protect your 
privacy while online.

To learn more about screen names:

1 Sign on to America Online. 

2 Go to Keyword: Help.

3 Select Getting Around & Using AOL from the topic menu.

4 Click Screen Names & Passwords.

More information about this topic 



More information about screen names

· The Master screen name (the first screen name you selected when you registered your America Online account) 
cannot be deleted or changed.

· Your account can have up to seven screen names, each with separate passwords, mailboxes, Personal Filing 
Cabinets, and Favorite Places.



  To store passwords for Automatic AOL 

1 On the My AOL menu, click Preferences.

2 In the Preferences window, click Auto AOL.

3 Click Select Names.

4 Select the screen names you want Automatic AOL to use.

5 Type passwords for the screen names you selected.

Notes

· If you are online when you activate Automatic AOL, it will run only for the screen name you are signed on with.

· If you want to activate Automatic AOL for all the screen names you selected when you set up Automatic AOL, 
sign off before you activate Automatic AOL.

             Related Topics   –   Automatic AOL  
             Related Topics   –   Preferences  



  About the Buddy ListÒ feature

The Buddy List feature lists the screen names of friends and family who are online when you're online — allowing for 
easy, spontaneous communication using either the Instant Message feature, or by setting up a private chat room. You 
can add or remove people from your Buddy List group at any time.

To learn more about the Buddy List feature:

1 Sign on to America Online.

2 Go to Keyword: Help.

3 Select the People Connection topic.

4 Click Buddy List feature.

             Related Topics   –   Chatting with friends  



 To read a log file 

1 On the File menu, click Open. 

2 Double-click the log filename you want to read.

Notes

· If your log file is larger than 30K, you will not be able to read it within America Online. Instead, use a word 
processing program to read it.

             Related Topics   –   Log Manager  



What's the name of the log file?

· The default name for a session log file is session.log

· The default name for a chat log file contains the name of the chat room you were in when you opened the log.



  To open a session log file 

1 On the My Files menu, click Log Manager.

2 In the Session Log section of the dialog box, click Open Log.

3 Click OK in the Open Log dialog box to create a file named session.log.    (Move this help window if it is in the 
way.)

             Go back to overview  



 To transfer text to the log file 

1 If you are offline, sign on to America Online. 

2 Navigate to the items you want to read offline.

3 Open the new articles or other text items to transfer the text to the log file. 

             Go back to overview  



  About the Log Manager

The Log Manager feature enables you to transfer online text to a file you can read or print offline.    You can transfer 
text from:

· News or reference articles

· Message board posts

· Instant Message conversations

· Chat rooms and auditoriums

             Related Topics   –   Log Manager  



 To open an Instant MessageÒ log file

1 On the My Files menu, click Log Manager.

2 In the Session Log section of the dialog box, click Open Log.

3 Click OK in the Open Log dialog box to create a file named session.log.    (Move this help window if it is in the 
way.)

4 Select the Log Instant Message check box.

             Go back to overview  



  To open a chat log

1 On the My Files menu, click Log Manager.

2 In the Chat Log section of the dialog box, click Open Log.

3 Notice the name of the log file and click OK.    (Move this help window if it is in the way.)

             Go back to overview  



  To enter a chat room or auditorium 

1 Sign on to America Online.

2 On the People menu, click People Connection.

3 Enter the chat room or auditorium you want to log.

             Go back to overview  



 To log a chat session 

You can do other things on the service while the chat is being logged, so long as the chat window remains open.

             Go back to overview  



  To use Automatic AOL to read e-mail offline

Overview 
(For detailed instructions on any step, click the button)

             Set up Automatic AOL to send and retrieve your e-mail.  
             Activate Automatic AOL (to retrieve e-mail that is waiting for you).   
             Read and respond to your e-mail offline.   
             Activate Automatic AOL (to send your outgoing e-mail).  
             Related Topics   –   Automatic AOL  



  To use the Log Manager to read news articles and other text items offline

Overview 
(For detailed instructions on any step, click the button)

             Open a session log file.  
             Open the news articles or text items you want to read offline.  
             Close the log file.  
             Sign off America Online and read or print the log file.  
             Read or print the log file.  
             Related Topics   –   Log Manager  



 To close the log file

1 On the My Files menu, click Log Manager.

2 In the Session Log section, click Close Log.    (Move this help window if it is in the way.)

3 Close the Log Manager window.

             Go back to overview   



  To save conversations from chat rooms and auditoriums

Overview 
(For detailed instructions on any step, click the button)

             Enter a chat room or auditorium.  
             Open a chat log.  
             Keep the chat room or auditorium window open while you do other things around the service.  
             Close the log file.  
             Sign off America Online and read or print the log file.  
             Related Topics   –   Log Manager  



 About the Instant MessageÒ feature

The Instant Message feature allows you to have immediate, one-on-one, private chats in real time with other AOL 
members who are online at the same time as you (or with non-AOL members using AOL Instant Messenger®). The 
next time you’re connected to AOL, check to see if a friend or relative is online and use the Instant Message feature 
to send him or her a direct personal note.

To learn more about the Instant Message feature:

1 Sign on to America Online.

2 Go to Keyword: Help.

3 Select People Connection from the topic menu.

4 Click Instant Message Feature. 
             Related Topics   –   Chatting with friends  



  About Keywords

Keywords make it possible for you to jump around quickly online, without having to remember exactly how you got to 
a certain area. 

As you explore America Online, notice the Keyword that is displayed in the lower right corner of the window. When 
you want to return to that area, you can use the Keyword feature to go there directly.

To go to a Keyword:

1 Sign on to America Online.

2 Type the keyword for the area you want to go to into the text entry box on the toolbar.

3 Press Enter. 
             Related Topics   –   Favorite Places  



  About Favorite Places

The Favorite Places feature allows you to bookmark and return to the sites that are of the most interest to you on AOL 
and on the Web. Once a site is saved as a Favorite Place, you can access it again quickly by selecting it from the 
Favorites menu. 

             Related Topics   –   Favorite Places  



 To mark a site as a Favorite Place

1 Sign on to America Online.

2 Navigate to the site you want to mark as a Favorite Place.

3 Click the  icon at the top right of the window.

4 In the dialog box that appears, click Add to Favorites.

             Related Topics   –   Favorite Places  



 To return to a Favorite Place

1 Sign on to America Online.

2 On the Favorites menu, click the Favorite Place you want to return to.

             Related Topics   –   Favorite Places  



  About the Member Directory

The AOL Member Directory is a searchable database that helps you locate AOL members who have similar interests 
and hobbies. AOL Members who have not created a Member Profile do not appear in the search results. 

To learn more about the AOL Member Directory and how to create a Member Profile:

1 Sign on to America Online.

2 Go to Keyword: Help.

3 Select the People Connection topic.

4 Click Member Directory.

             Related Topics   –   Chatting with friends  



 To change the font or typestyle in your e-mail

1 Click Write.

2 Type the text of your e-mail message.

3 Highlight a section of text to select it.

4 Click the font or other character attribute you want to use from the style toolbar at the top of the message box.

More information about this topic

             Related Topics   –   E-mail  



More information about using fonts and typestyles in e-mail

You can also click your right mouse button and select from the pop-up menu that appears.



  To add folders to your Personal Filing Cabinet

1 On the My Files menu, click Personal Filing Cabinet.

2 Click the location for the new folder.

3 Click Add Folder.

More information about this topic 

             Related Topics   –   Personal Filing Cabinet  



More information about adding folders

· If you select a folder, the new folder will be created inside the selected folder.

· If you select a document, the new folder will be inserted before the document.



 To re-arrange the contents of your Personal Filing Cabinet

1 On the My Files menu, click Personal Filing Cabinet.

2 Drag a folder or file to a new location within the Personal Filing Cabinet.

             Related Topics   –   Personal Filing Cabinet  



  To select multiple files or folders

1 On the My Files menu, click Personal Filing Cabinet.

2 Hold down the Ctrl key, and click each item you want to select.

Notes

· Hold down the Shift key and click two non-contiguous items to select all items in between.

· Hold down the Ctrl key and click a selected item to undo the selection.

             Related Topics   –   Personal Filing Cabinet  



  To delete an item from your Personal Filing Cabinet

1 On the My Files menu, click Personal Filing Cabinet.

2 Click the item you want to delete.

3 Click Delete.

More information about this topic 

             Related Topics   –   Personal Filing Cabinet  



More information about deleting from the Personal Filing Cabinet

· To access the Personal Filing Cabinet for other screen names on your account, select a different screen name 
from the Select Screen Name list on the Sign On screen.

· You can use multiple selection techniques to select more than one item at a time for deletion.

· If you delete a folder, you will also delete all items inside the folder.

· You can only delete folders you have created in the Personal Filing Cabinet. 



  About the Personal Filing Cabinet

· The Personal Filing Cabinet helps you organize items retrieved online by Automatic AOL (files you have 
downloaded, incoming e-mail, unread message boards and newsgroups) and items assembled for the next time 
Automatic AOL is activated (files to be downloaded, outgoing e-mail, outgoing message board and newsgroup 
posts). 

· You access your Personal Filing Cabinet from the My Files icon on the toolbar.

· Each screen name has its own Personal Filing Cabinet, stored in a single file in the America Online 
5.0\ORGANIZE folder.      You must use the Personal Filing Cabinet feature within America Online to access the 
information in this file.

· You cannot access your Personal Filing Cabinet if you sign on as a Guest from another member's computer.

             Related Topics   –   Personal Filing Cabinet  



 To search the Personal Filing Cabinet

1 On the My Files menu, click Personal Filing Cabinet.

2 Click Find.

3 Specify the search criteria.

More information about this topic 

             Related Topics   –   Personal Filing Cabinet  



More information about searching

You can use a more limited search function, Find in Top Window on the Edit menu, anywhere on the service. 



 To save copies of your e-mail

You can save copies of your e-mail in two ways: 

· Save your e-mail to your computer or disk. 

· Save your e-mail to your Personal Filing Cabinet. 

Notes

· E-mail you save in your Personal Filing Cabinet will remain on your computer until you delete it.

             Related Topics   –   E-mail  



  To recover unused space in your Personal Filing Cabinet

1 On the My Files menu, click Personal Filing Cabinet.

2 Click Compact PFC.

Why do I need to do this? 

             Related Topics   –   Personal Filing Cabinet  



    Why do I need to do this?

When you delete files from your Personal Filing Cabinet, the database file is not compacted, and empty space on 
your computer is not reclaimed until you run this utility.



  To control the size of your Personal Filing Cabinet

1 On the My AOL menu, click Preferences.

2 In the Preferences window, click Personal Filing Cabinet.

3 Adjust the warning sizes (for the size of the Personal Filing Cabinet and the percent of free space) as desired.

More information about this topic

             Related Topics   –   Personal Filing Cabinet  



More information about the size of the Personal Filing Cabinet

· Information is not automatically deleted from your Personal Filing Cabinet.    As you no longer want items, you 
must delete them.

· Compacting the Personal Filing Cabinet will reclaim unused space left when you delete items.



  To add a name to your address book from e-mail you receive

1 Open any piece of e-mail.

2 Highlight the e-mail address(es) you want to add to your address book to select it.

3 Click Add Address. 

Notes

· If you don’t select an address, the address of the person who sent you the e-mail will be added.

· If you select more than one address, each address will be added as a separate entry.    To create a group listing, 
select the names you want added together as a group, and hold the Ctrl key down as you click Add Address.

             Related Topics   –   E-mail  
             Related Topics   –   Address Book  



  To use the address book when you send e-mail

1 Click Write.

2 In the Write Mail window, click Address Book.

3 Double-click a name from your address book.    The address will be added as a recipient of your e-mail.

             Related Topics   –   E-mail  
             Related Topics   –   Address Book  



To send e-mail

1 Click Write.

2 In the Send To: box, type the e-mail address of the person you want to send e-mail to. (To send the same 
message to another person, type a comma and add the next e-mail address.)

3 In the Subject: box, type a subject line for your e-mail. 

4 Type your message in the large message box. 

5 When you have finished, click Send Now or Send Later.

Notes

· If you click Send Now, your e-mail will be sent immediately. The Send Now button is active only when you are 
online.

· If you click Send Later, your e-mail will be stored in your offline mailbox until you activate Automatic AOL to send 
your outgoing e-mail.    The Send Later icon is not active when you are using the Guest screen name.

             Related Topics   –   E-mail  



 What’s the difference between Send Now and Send Later?

If you click Send Now, your e-mail will be sent immediately. The Send Now button is active only when you are online.

If you click Send Later, your e-mail will be stored in your offline mailbox until you activate Automatic AOL to send 
your outgoing e-mail.    The Send Later icon is not active when you are using the Guest screen name.



 To read your saved e-mail

1 On the Mail Center, point to Read Offline Mail on the menu.

2 Click Incoming/Saved Mail or Copies of Mail You’ve Sent.

3 In the Offline Mail window, double-click the e-mail item you want to read.

             Related Topics   –   E-mail  



 How does e-mail get into the offline mailbox?

E-mail is stored in the offline mailbox:

· If you use Automatic AOL to retrieve your online mail;

· If you set a preference to save copies of your e-mail.

             Related Topics   –   E-mail  



 To read e-mail that is waiting to be sent with Automatic AOL

1 On the Mail Center menu, point to Read Offline Mail and click Mail Waiting to be Sent.

2 In the Offline Mail window, double-click the e-mail item you want to read.

             Related Topics   –   E-mail  



 To attach a file to your e-mail

1 Click Write.

2 In the Write Mail window, click Attachments.

3 Navigate to the folder that contains the file you want to attach.

4 Double-click the file to attach and click OK.

             Related Topics   –   E-mail  



For example

AOLmember1 
(for friends who are also members of America Online)

or

xyz_person@xyzcompany.com 
(for friends who have an Internet e-mail address)



The subject line

Select a simple title for your message; it doesn’t have to be complicated. For example:

Hello there! 

The title you enter will appear in the recipient's list of New Mail, so the reader can quickly tell what your message is 
about.



 To add pictures and text to your e-mail

You can embed pictures and text directly into your AOL e-mail, enhancing your message and eliminating the need for 
a recipient to download a file. By using a favorite image as a background to your e-mail, you can even create your 
own online stationery.

Click the  icon on the style toolbar at the top of the message box to:

· Insert a picture into an e-mail 

· Add a background picture to an e-mail 

· Insert a text file into an e-mail 

             Related Topics   –   E-mail  
             Related Topics   –   Image Files  



 To insert a picture in an e-mail

Inserting a picture into your e-mail places the image in the body of your e-mail. The text that you type flows around 
the picture.

1 Click Write.

2 Click the  icon on the style toolbar (above the message box).

3 Select Insert a Picture from the menu that appears.

4 In the Open window, navigate to the folder that contains the image file and double-click the file name to insert the 
image into your e-mail.

5 Position your cursor either before or after the image, and type your message.

Notes

· Only other members of AOL using version 4.0 or above will be able to see the image files you insert in your e-
mail. 

· If you want text to appear above your picture, type your message before inserting the picture.

· If you want to send an image file to an Internet address, or to an AOL member who is using an earlier version of 
the software, you will have to attach the file to your e-mail.

             Related Topics   –   E-mail  
             Related Topics   –   Image Files  



  To use an image file as a background in your e-mail

Adding an image as a background picture in your e-mail makes your picture fill the background behind your message. 
The text that you type appears on top of the background picture.

1 Click Write.

2 Click the  icon on the style toolbar (above the message box) and select Background Picture from the 
menu that appears.

3 In the Open window, navigate to the folder that contains the image file and double-click the file name to insert the 
image as a background in your e-mail.

4 Position your cursor on the image and type your message.    The text will appear on the photograph.

Notes

· Only other members of AOL using version 4.0 or above will be able to see the image files you insert in your e-
mail. 

· If your picture has a dark background, use a light color for the text.

· If you want to send an image file to an Internet address, or to an AOL member who is using an earlier version of 
the software, you will have to attach the file to your e-mail.

             Related Topics   –   E-mail  
             Related Topics   –   Image Files  



 To set a default font for your e-mail

1 On the My AOL menu, click Preferences.

2 In the Preferences window, click Font. (Move this help window if it is in the way.)

3 Select the font, size, style and color you want to use as the default when you send e-mail.

4 Click OK.

             Related Topics   –   E-mail  
             Related Topics   –   Preferences  



       To use Automatic AOL to read message boards    and newsgroups offline

Overview 
(For detailed instructions on any step, click the button)

             Select message boards for Automatic AOL to retrieve.  
             Select the newsgroups you want to read offline.  
             Set up Automatic AOL to send and retrieve postings.  
             Activate Automatic AOL (to retrieve unread message board posts).  
             Read (and respond to) the messages in your Personal Filing Cabinet.  
             Activate Automatic AOL (to send outgoing message board posts).  
             Related Topics   –   Automatic AOL  



  To select message boards for Automatic AOL to retrieve

1 Sign on to America Online. 

2 Open the message board you want to read offline.

3 Click a folder once to select it and click Read Offline. 

             Go back to overview   



 If you click Reply to Author . . .

You will need to set up Automatic AOL to send outgoing mail before your response will be sent.

             Setting up Automatic AOL to send outgoing mail   



 To require a password to access your Personal Filing Cabinet

1 Sign on to America Online.

2 On the My AOL menu, click Preferences.

3 In the Preferences window, click Passwords.

4 Type the password for your screen name in the Password box. 

5 Select the Personal Filing Cabinet check box.

             Related Topics   –   Personal Filing Cabinet  
             Related Topics   –   Preferences  



  To attach multiple files to an e-mail

1 Click the Write icon on the toolbar.

2 Click Attachments.

3 In the Attachments window, click Attach.

4 Navigate to the folder that contains the file you want to attach.

5 Double-click the file you want to attach. 

6 Repeat steps 3-5 until you have selected all the files you want to attach and click OK.

             Related Topics   –   E-mail  
             Related Topics   –   Attached Files  



  To list the file attachments

On the Write Mail window, click Attachments.        A window will appear listing any files that you attached.

             Related Topics   –   E-mail  
             Related Topics   –   Attached Files  



 To detach a file

1 On the Write Mail window, click Attachments.      A window will appear listing the files that you attached.

2 Click the file you want to detach once to select it.

3 Click Detach.

             Related Topics   –   E-mail  
             Related Topics   –   Attached Files  



  To check your spelling

1 Click Write.

2 Compose your e-mail as usual.

3 Click the  icon on the style toolbar at the top of the message box. The AOL software checks your message. 

If an error is found, the spell-checking window appears, explains the error, and suggests corrections for it.

4 In the spell-checking window, click the misspelled word, type in your corrections (or select one of the words from 
the Suggestions list), and click Replace. 

Notes

· You can check the spelling in any text you type within America Online by selecting Spell Check from the Edit 
menu.

· You can set your software up to check your e-mail automatically.

· You can customize the spelling checker to only notify you of certain types of errors.

             Related Topics   –   E-mail  



  To set a preference to check your spelling automatically

1 On the My AOL menu, click Preferences.

2 In the Preferences window, click Mail.

3 Select the Perform a spell check before sending mail check box.

Notes

· If you want to send e-mail without checking the spelling, hold the Ctrl key down when you click Send Now.

             Related Topics   –   E-mail  
             Related Topics   –   Preferences  



  To sign off America Online and read or print the log file

1 On the Sign Off menu, click Sign Off.

2 On the File menu, click Open. 

3 Double-click the log filename you want to read or print.

4 On the File menu, click Print to print the file.

Notes

· If your log file is larger than 30K, you will not be able to read it within America Online. Instead, use a word 
processing program to read it.

             Go back to overview  



     Dialing Options

I do not have touch tone service

Select this check box if your phone does not use touch-tone dialing. 

Dial [9,    ] to reach an outside line

Select this check box if you need to dial a prefix (for example, 9) to reach an outside line. Edit the default prefix if it is 
not correct, and make sure there is a comma after it.

Dial [*70,    ] to disable call waiting

Select this check box if you have call waiting on your phone line.

More information about this topic 

             Close help and continue   



  To create a keyboard shortcut

1 On the Favorites menu, point to My Shortcuts and then click Edit Shortcuts.

2 In the Shortcut Title box, type a name for the shortcut.

3 In the Keyword/Internet Address box, type the Keyword or URL you want to associate with the shortcut and 
click Save Changes.

Notes

· To use the shortcut, press Ctrl + n  (where n is the Key on the right of the window).

             Related Topics   –   Favorite Places  



 To set your online mailbox preference

1 Sign on to America Online.

2 On the My AOL menu, click Preferences.

3 In the Preferences window, click Mail.

4 Set the Keep my old mail online preference as desired.

             Related Topics   –   Preferences  



       Is it an ordinary dial tone?

             Yes.  
             No, it  ’  s a voice message dial tone.  



    To add a pause to wait for the regular tone

1 On the Sign On screen, click Setup.

2 On the AOL Setup screen, click Expert Setup.

3 On the Locations tab in the Connection Setup window, click the number (connection) you want to edit once to 
select it. The number (connection) is indented beneath the location name.

4 Click Edit.

5 In the Edit Number (Connection) window, select the Dial [9,    ] to reach an outside line: check box.

6 Delete the default code that is in the box and type two commas into the box. 

Notes

· You will have to edit each number in the location and make this change.

             Related Topics   –   Setup  



  To move (or copy) a number (connection)

1 On the Sign On screen, click Setup.

2 On the AOL Setup screen, click Expert Setup.

3 Click the Locations tab.

· To move a number (connection) to another location or to a different position in the same location, drag the 
number to the new position. 

· To copy a number (connection), hold the Ctrl key down as you drag the number to a new location or position.

4 Click Close.

             Related Topics   –   Setup  



  Select Access Phone Numbers window

1 Click an access phone number from the list on the left once to select it and click Add.

2 Verify the information in the Add AOL Access Phone Number window, and click Next.

3 Repeat steps 1-2 until you have added as many access phone numbers to this location as you want, then click 
Next.

Notes

· To add the access phone number to another location, select the desired location from the Selected numbers 
will be added to: list.

             Close help and continue   



  Add/Edit Number (Connection) window

Name

Edit the name of the number (connection) (for example, Santa Clara access number).

Will be added to this location:

Select the location you want to add this connection profile to.

Connect using:

Select the connection method this connection profile will use (for example, a modem or TCP/IP).

Try to connect [ 5    ] times with this number (connection).

Click the up or down arrow to adjust the number of times you want the software to try to connect using this profile.

Edit number here:

If you need to edit the number, do so in this box. Note that if you need to dial an area code, use the following format, 
for example 703-555-0909.

             More help   —      modem numbers (connections)   
             More help   —   TCP/IP numbers (connections)   



  Add/Edit Number (Connection) window (modem)

Dial [9,    ] to reach an outside line

Select this check box if you need to dial a prefix (for example, 9) to reach an outside line. Edit the default prefix if it is 
not correct, and make sure there is a comma after it.

Dial [*70,    ] to disable call waiting

Select this check box if you have call waiting on your phone line.

More information about disabling call waiting 

To dial a “1” and/or an area code before the access phone number

Add the necessary numbers to the access phone number in the Edit number here box.    (You will incur phone 
charges if you select an AOL access phone number that is a long distance call for you, or is not covered by your local 
calling plan. Please check with your local phone company for more information). Use the following format, for 
example 703-555-0909

Speed

Select the highest speed at which your modem can transmit data (not fax.)

Network

Verify that the correct network is selected for the access number you are using (for example, AOLnet).

             Close help and continue   



 To create a custom proxy configuration

1 On the Sign On screen, click Setup.

2 On the AOL Setup screen, click Expert Setup.

3 Click once on a TCP/IP number (connection) to select it and click Edit.

4 In the Edit Number (Connection) window, select the Manual Proxy Configuration check box.

5 Click View to enter your custom settings.

6 Click OK.

             Related Topics   –   Setup  
             Close help and continue   



  To set preferences

1 On the My AOLmenu, click Preferences.

2 Click the icon for the preferences you want to set.

             Related Topics   –   Preferences  



  Expert Add window — (modem)

1 Select your modem from the Modem: list.

2 Select the com port your modem is using from the Connected to port: list. 

3 Select the highest rate at which your modem can transmit data (not fax) from the Port speed: list.

             Close help and continue   
             Creating custom modem commands  



  Expert Add window — (TCP/IP)

· Select    Automatic Connection Script for most ISP and LAN TCP/IP connections.

· Select Manual Proxy Configuration if you need to configure a custom TCP/IP connection to communicate 
outside your LAN.    (Click View to enter your custom settings.)

             Close help and continue   



  About Numbers (Connections) 

A number (connection) contains the information your computer needs to connect to America Online — such as what 
type of modem you have (or whether you use TCP/IP to connect) and what access phone numbers to use to connect. 



  About Locations

A location contains one or more numbers (connections) that contain a common element (for example, several 
numbers that will connect you from a certain city).    If you have America Online on your laptop computer, you can 
create separate locations for use at home, at your office, or in the cities you travel to frequently. 



  To use the Find in Top Window feature

1 Click anywhere in the AOL window you want to search to make it the active window.

2 On the Edit menu, click Find in Top Window.

3 Type the word or phrase you want to search for and click Find.

Notes

· If you are searching in the Personal Filing Cabinet , you can use the Find feature to search the entire contents of 
the PFC.



     About Capture Picture 

The Capture Picture feature is available if you have a digital camera installed on your computer.    It allows you to take 
pictures and save them directly to your computer, so you can send them to your friends in e-mail.

             Related Topics   –   Capture Picture  
             Related Topics   –   Image files  



    To take a picture and save it on your computer

1 On the Edit menu, click Capture Picture.

2 Adjust the camera angle and picture quality until you are ready to take a picture.

3 Click Capture.

4 On the File menu, click Save.

5 Type a name for the image file and navigate to the folder where you want to save it on your computer and click 
OK.

Notes

· You must have a digital camera installed on your computer to use the Capture Picture feature.

· To return to Preview mode so you can take another picture, click Preview.

             Related Topics   –   Capture Picture  
             Related Topics   –   Image files  



     To adjust the picture quality 

1 On the Edit menu, click Capture Picture.

2 In the Capture window, click Settings.

3 Select the type of adjustment you want to make (for example, Picture Size & Quality).

Notes

· For more help with picture quality adjustments, see the manual that came with your digital camera.

             Related Topics   –   Capture Picture  
             Related Topics   –   Image files  



     To edit a picture in the Picture Gallery

1 On the File menu, click Open Picture Gallery.

2 Navigate to a folder on your disk that contains image files.

3 Click Open Gallery. The Picture Gallery window will appear, with the first 6 images in the folder.

4 If you have more than 6 image files in the folder, click the right arrow to move to the next set of 6 images.

5 Click the picture you want to edit.

6 Click the  icon above the picture to display the image file editing tools.

7 When you have finished editing the picture, click Save.

Notes

· To see the function of an image-editing tool before you use it, hold your mouse over the tool for a few seconds.

             Related Topics   –   Picture Gallery  
             Related Topics   –   Image files  



  To use the Picture Gallery to send pictures in e-mail

1 On the File menu, click Open Picture Gallery.

2 Navigate to a folder on your computer that contains image files.

3 Click Open Gallery. The Picture Gallery window will appear, with the first 6 images in the folder.

4 If you have more than 6 image files in the folder, click the right arrow to move to the next set of 6 images.

5 Click the picture you want to use. 

6 Click Insert in E-mail.

             Related Topics   –   Picture Gallery  
             Related Topics   –   Image files  



     About the Picture Gallery 

The Picture Gallery allows you to preview up to 6 image files at a time from the same folder.    This makes it easy to 
decide which ones to add to your e-mails.    You can also edit the pictures themselves from the Picture Gallery and 
change the contrast, rotation, brightness, etc.

             Related Topics   –   Picture Gallery  
             Related Topics   –   Image files  



 To set language preferences

1 On the My AOL menu, click Preferences

2 In the Preferences window, click Language. 

3 From the Available Languages list, select the language you want displayed on AOL screens in International 
areas. 

4 Click Add >> to add the selected language to your list of Preferred Languages on the right.

5 Repeat steps 3-4 to add all of your Preferred Languages.

6 Click OK to confirm your language preferences.

Notes

· Language preferences control the language used in some of the online areas you visit. (The International 
channel (Keyword: International) contains many areas in different languages, just as if you were using an 
international version of America Online.)

· Not all online areas are affected by changing the language preferences.
             Related Topics   –   Preferences  



This box displays a preview of the picture you are working with. This box remains blank if you are working with a text 
file.



Select this check box to show a preview of the image you are working with. Clear this check box to turn off the 
preview feature.



  To turn off the Automatic AOL Scheduler

1 On the Mail Center menu, click Set Up Automatic AOL (Flashsessions).

2 Click Schedule Automatic AOL.

3 Clear the Enable Scheduler check box.

4 Click OK. 

             Related Topics   –   Automatic AOL  



 Modem Installation Checklist
If you have an external modem:

1 Make sure the modem's power cord is securely plugged in and that the modem is turned on. If the modem has 
power, then its LED lights or LCD display should be on.

2 Make sure the modem cable is securely attached to the modem and to the computer.

If you have an internal modem:

1 Quit all software programs that are running.

2 Click Start on the Windows taskbar and select Shut Down. 

3 Select the option to shut down your computer and click OK (or Yes.) 

4 If your computer does not turn off automatically, wait until you see the message that it is safe to do so, and turn off 
your computer.

5 Wait 10–15 seconds.

6 Restart your computer.

For all modems:

1 Make sure the phone line coming from the wall is plugged into the modem connection that reads PHONE LINE, 
JACK, or TO WALL.

2 Unplug the line going into the modem and connect it to a phone; listen for a normal dial tone.

3 Check to see if an extension is off the hook.

4 Make sure the correct modem has been selected in the AOL setup.

Notes

· If you subscribe to a home-based voice-mail service offered by many telephone companies, the special tones 
used to identify the existence of a message can interfere with the normal operation of your modem.    Check for 
this interference by listening for a normal dial tone from your telephone receiver.

· If you have a Meridian, Aspect, Rolm, or other digital phone system (normally used only in office buildings), then 
your phone system probably is not compatible with your modem (standard modems send analog signals).

             Related Topics   –   Setup  
             Related Topics   –   Modems  



 To use Auto Detect to identify your connection devices

1 On the Sign On screen, click Setup

2 On the AOL Setup screen, click Expert Setup.

3 On the Connection Setup window, click the Devices (modems, etc.) tab.

4 Click Auto Detect. 

5 When the connection devices on your computer have been detected, select the one you want to use to connect 
and click Next.

             Related Topics   –   Setup  
             Related Topics   –   Modems  



  If Your Modem Detected a Timeout

1 Check that the correct modem has been selected.

2 Try another access number.

3 Determine if voice messages are interfering with your connection.

4 Determine if you must dial a prefix to get an outside line. (If you are dialing from an office location, then you may 
need to set up your modem to dial a number or prefix before dialing your AOL access number.)



 To check for dialing problems

Check for dialing problems if

· you subscribe to a home-based voice-mail service, which may send signals over your phone line that interfere 
with your modem connection.

· you have chosen an access number that requires you to dial “1” and the area code to connect.

· you are dialing from an office building (where you may need to dial a number — such as “9” — to place an 
outside call).

To check for dialing problems:

1 Disconnect the phone line from your modem and connect the it to a telephone.

2 Dial the AOL access number exactly as it is listed in your AOL setup.

3 Listen for the call to go through and a modem to answer.

Notes

· The phone company may charge you for connecting to AOL access numbers, depending on your location and 
calling plan. Please check with your phone company to ensure that the AOL access number you use is 
considered a local call within your calling plan.



Access number does not connect?

1 Try connecting with another access number.

2 If another access number is not available to your area, you may want to contact technical support. 

Notes

· Please report problems with access numbers so AOL can investigate the problem.

Did this fix the problem?
             Yes.  
             No, I still need more help.  



Using Expert Setup

Use Expert Setup to

 configure your modem to dial an outside phone line. 
 configure for pulse dialing. 
 turn off call waiting while you are online. 
 configure your modem manually. 
 edit the modem commands. 
 check for correct modem selection. 



 To add a Favorite Place hyperlink to your e-mail

1 Click Write.

2 Click the  icon on the style toolbar on top of the message box.      (Move this help window if it is in the way.)

3 Point to the Favorite Place folder that contains the hyperlink and click the hyperlink to add it to the e-mail.

Why would I want to add a hyperlink? 

Notes

· If you are online when you write your e-mail, you can also drag the  from any window title bar to your e-mail.

             Related Topics   –   E-mail  



Why would I add a hyperlink to my e-mail?

If you have found an interesting place on America Online, or the World Wide Web, why not share it with a friend?    If 
you place a hyperlink reference in your e-mail, your friend will be able to click the hyperlink and go directly to the 
information you have found — right as they are reading your e-mail.



  About chat rooms

Chatting online is one of AOL's most popular features. Chat rooms allow you to talk in real time to other AOL 
members about anything you are interested in: You type your message and it is instantly displayed to everyone in the 
virtual room that you have entered.    The rooms are actually areas where groups gather to discuss similar hobbies 
and lifestyles. There is a wide variety of rooms from which to choose, and you can even create your own room if you 
don’t see something you like. 

To learn more about chat rooms:

1 Sign on to America Online.

2 Go to Keyword: Help.

3 Select People Connection from the topic menu.

4 Click Chatting Online.
             Related Topics   –   Chatting with friends  



 About member profiles

Member Profiles tell other AOL members about you and your hobbies and interests. If you do not create a member 
profile, then information about you does not appear in the AOL Member Directory. 

To learn more about member profiles: 

1 Sign on to America Online.

2 Go to Keyword: Help.

3 Select People Connection from the topic menu.

4 Click Member Directory.

5 Look for the article on creating a member profile. 

More information about this topic 

             Related Topics   –   Chatting with friends  



  To set privacy preferences

1 Sign on to America Online. 

2 On the My AOL menu, click Preferences.

3 On the Preferences window, click Privacy. 

4 Select your privacy preferences.

5 Click Save.

             Related Topics   –   Online Security  
             Related Topics -- Preferences  



 Setting toolbar preferences

You can set the toolbar in the Web browser to include your own graphical buttons, change its location on the screen, 
and customize it with shortcuts to make it the most useful for you.

To set toolbar preferences:

1 On the My AOL menu, click Preferences.

2 In the Preferences window, click Toolbar.

3 Select your preferences for appearance and location of the toolbar and click OK.
             Related Topics   –   Preferences  



 To customize the spelling checker

1 On the My AOL menu, click Preferences.

2 Click Spelling.

3 Select your preferences for the spelling checker and click OK.

Notes

· When you first open the Spelling Preferences window, all options will be selected. To turn off a function, clear 
the check box next to the function.

· For even more fine-tuning, click Advanced.

             Related Topics   –   Preferences  



 To save e-mail to your computer or disk

1 Sign on to America Online.

2 Click Read.

3 Click the Old Mail tab to bring mail to the front that you have already read. 

4 Double-click message you want to save, to open it. 

5 On the File menu, click Save As.

6 In the Save As window, navigate to the folder on your computer where you want the e-mail to be stored.

7 Type a filename for your e-mail in the Filename: box. (You should make a note of where you store the mail and 
the name you give it so that you can find it easily later.)

8 Click Save.
             Related Topics   –   E-mail  



 To save e-mail to your Personal Filing Cabinet

1 Sign on to AOL.

2 On the My AOL menu, click Preferences. 

3 In the Preferences window, click Mail.

· To save outgoing mail, select the Retain all mail I send in my Personal Filing Cabinet check box. 

· To save incoming mail, select the Retain all mail I receive in my Personal Filing Cabinet check box.

Notes

· To open your PFC, click Personal Filing Cabinet on the My Files menu. (You can read mail stored in your PFC 
when you are not signed on to AOL.) 

             Related Topics   –   Personal Filing Cabinet  



 To insert a text file into an e-mail

1 Click Write.

2 Click the  icon on the style toolbar (above the message box) and click Insert Text File. 

3 Navigate to the folder that contains the text file and double-click the file name to insert the text into your e-mail.

4 Position your cursor either before or after the inserted text.

5 Type and send your message as usual.

Notes

· You can only insert files with the .txt extension into your e-mail message.

             Related Topics   –   E-mail  



WARNING!

Files sent over the Internet or through e-mail can contain computer viruses or Trojan Horse programs. Viruses and 
Trojan Horse programs can cause harm to your computer files, may contain objectionable graphics, or can even 
compromise the security of your AOL account. When downloading files, you should always check for viruses and 
Trojan Horse programs before you open the files. To learn more about computer viruses and to get anti-virus 
software, visit the AOL Computer Protection Center at Keyword: Virus Info.



 Downloading files if you have an hourly billing plan

If you have an hourly billing plan, your account is charged for the time it takes to download all files stored in the 
Download Manager, whether or not those files originally came from the unlimited use area. 

To avoid being charged for downloading files located in the unlimited use area, always use the Download Now 
button while you are in the unlimited use area.

             Related Topics   –   Downloading  



 To decompress files that you have downloaded

A file with the .zip extension is in compressed format and must be decompresed, or “unzipped” before you can use it. 
If you've downloaded a compressed file, you can decompress that file automatically using the Download Manager.

To decompress files using the Download Manager:

1 On the My Files menu, click Download Manager. 

2 Click Show Files Downloaded.

3 Click a file with the .zip extension to select it. 

4 Click Decompress to unzip the file. The expanded file(s) will be placed in the same folder to which you 
downloaded the zipped file.

             Related Topics   –   Downloading  



 About MIME

MIME (Multipurpose Internet Mail Extensions) is a specification, or a set of guidelines, that software must use in order 
to work with other software. When you send an attachment with an e-mail message from AOL to someone over the 
Internet, MIME helps ensure that the recipient gets your attachment in a readable format -- whether it's graphics, 
sounds, or whatever you choose to send. 

On AOL, all you do is click Attach on your e-mail form, and the AOL software automatically does the rest. Likewise, 
when you receive a MIME-encoded attached file from an Internet address, the AOL software will decode the file for 
you -- invisibly and automatically. The AOL software is what is known as MIME-compliant. As long as your 
correspondents also have e-mail software that is MIME-compliant (and most email software is), you can swap files. 

Occasionally, you might need to decode a MIME file yourself. You'll need a MIME decoder if you receive an e-mail 
attachment and the file name ends in .mme or .mim. You can download a mime decoder at Keyword: Filesearch.

             Related Topics   –   Email  
             Related Topics   –   Downloading  



 To set up Automatic AOL

1 On the Mail Center menu, click Set up Automatic AOL (Flashsessions).

2 Select the tasks you want Automatic AOL to perform (retrieve unread mail, etc.).

3 Click Select Names. 

4 Select the screen names for which you'd like the tasks performed, and type the passwords for each screen name 
you select in the box provided.

5 Click OK.

Notes

· Anyone who has physical access to your computer can sign on to your account if you store your password. 

· If you decide not to store your passwords, you can sign on to America Online with each screen name and start 
Automatic AOL manually while you are online.

             Related Topics   –   Automatic AOL  



 To save Instant Message® conversations to a file
Overview 
(For detailed instructions on any step, click the button)

             Open a session log with the Log Instant Message option checked.  
             Continue your Instant Message® conversation.  
             Close the log file.  
             Sign off America Online and read or print the log file.  
             Related Topics   –   Log Manager  
             Related Topics   –   Chatting with friends  



  To send an Instant Message® note

1 Sign on to America Online. 

2 On the People menu, click Instant Message.

3 In the Send To: box, type the recipient's screen name.

4 Type your message.

5 Click Send.

More information about this topic 

             Go back to overview   



  To copy your address book to another screen name

1 On the Mail Center menu, click Address Book.

2 Click Save/Replace. 

3 Select the Save the Address Book for your current screen name option and click OK. The Save Folder 
window will appear.  (You can accept the default file name [Address Book.pfc] or create a new name. The default 
location is the Download folder in your America Online 5.0 folder.) 

4 Click Save.

5 Switch to the screen name to which you want to copy your Address Book.

6 On the Mail Center menu, click Address Book.

7 Click Save/Replace. 

8 Select the Replace with a Previously Saved Address Book option and click OK.

9 In the Select File to Restore window, select the Address Book.pfc file (or the new name you created) and click 
Open.

             Related Topics   –   E-mail  
             Related Topics   –   Address Book  



 About Master Screen Names

The primary Master Screen Name—the first screen name you created when you first registered as an AOL member—
cannot be removed as a Master Screen Name.    Master Screen Name status can be assigned to a maximum of 2 
additional existing or newly created screen names besides the primary Master Screen Name.    To assign Master 
Screen Name status to a screen name, you must first assign it an 18+ rating through the Parental Controls feature.

A member logged in with a Master Screen Name can

· change the account's billing method and price plan.

· change the Parental Controls settings for other screen names on the account.

· create, delete, or restore screen names on the account.

             Related Topics   –   Online Security  



  To copy your Favorite Places to another screen name

1 On the Favorites menu, click Favorite Places.

2  Click Save/Replace. 

3  Select the Save the Favorite Places for your current screen name option and click OK.    The Save Folder 
window will appear.    (You can accept the default file name [FavoritePlaces.pfc] or create a new name. The 
default location is the Download folder in your America Online 5.0 folder.) 

4  Click Save.

5  Switch to the screen name to which you want to copy your Favorite Places.

6  On the Favorites menu, click Favorite Places.

7  Click Save/Replace. 

8  Select the Replace the Favorite Places for your current screen name option and click OK. 

9 In the Select File to Restore window select the FavoritePlaces.pfc file (or the new file name you created) and 
click Open. 

             Related Topics   –   Favorite Places  



 To set up the "display next message" option 

1 On the My AOL menu, click Preferences.

2 In the Preferences window, click Mail.

3 Select the Display next message when current message is deleted check box.

4 Click OK.

             Related Topics   –   Preferences  



 To set up AOL as your preferred browser

1 On the My AOL menu, click Preferences.

2 In the Preferences window, click Associations.

3 Click OK to select America Online as your preferred application for Web browsing, E-mail, and Newsgroups. 

Notes

· The e-mail and newsreader associations can be reset in the Internet Options Control Panel.

             Related Topics   –   Browser   
             Related Topics   –   Preferences  



 To designate a screen name as an additional Master Screen Name

1 Sign on to America Online with the Primary Master Screen Name.

2 On the My AOL menu, click Parental Controls.

3 Follow the instructions for setting parental controls.

Notes

· Read the information about Master Screen Name designation carefully.

· You can select up to two screen name(s) to designate as additional Master Screen Names.

             Related Topics   –   Online Security  



  To learn more about downloading

1 Sign on to America Online.

2 Go to Keyword: Help.

3 Select the Downloading Files & Attachments topic.

             Related Topics -- Downloading  



 To recover recently deleted e-mail

1 Sign on to America Online.

2 On the Mail Center menu, click Recently Deleted Mail.

3 In the Recently Deleted Mail window, select the piece of mail you want to retrieve.

4 Click Keep as New.    The e-mail will move to the New Mail tab in your online mailbox.

Notes

· E-mail can only be recovered for 24 hours after you delete it.

             Related Topics   –   E-mail  



 To clear the history trail

1 Sign on to America Online.

2 On the My AOL menu, click Preferences.

3 In the Preferences window, click Toolbar.

· To clear the history trail immediately, click Clear History Now.

· To clear the history trail every time you sign off or switch screen names, select the Clear history trail after each 
Sign Off….    check box.

             Related Topics   –   Preferences  



 To add a signature to your e-mail

1 Click Write.

2 Address the e-mail as usual.

3 Type your message.

4 Click the  icon on the style toolbar at the top of the message box and select the signature you want to use.

5 Send your e-mail as usual.

Notes

· The signature can be added to the e-mail at any time before you send it.

· You can edit the signature after it has been added to the e-mail without changing the stored signature.

             Related Topics   –   E-mail  
             Related Topics   –   Signatures  



 Setting up signatures to use in e-mail

1 On the Mail Center menu, click Set up Signatures.

2 In the Set up Signatures window, click Create.

3 In the Signature Name box, type a name for this signature (for example; My normal signature).

4 In the Signature box, type the text want to use as your signature, adding any text styling features you want from 
the style toolbar.

Notes

· You can create and save up to five signatures.

· You can designate one of the signatures as a default signature to be automatically inserted into the e-mail 
message box on all e-mails you write.

             Related Topics   –   E-mail  
             Related Topics   –   Signatures  



 To select a default signature for e-mail

1 On the Mail Center menu, click Set up Signatures.

2 In the Set up Signatures window, select the signature you want as your default signature and click Default 
On/Off.    The signature you selected will automatically be inserted into the e-mail message box on all subsequent 
e-mails you write.

             Related Topics   –   E-mail  
             Related Topics   –   Signatures  



 To turn off the default signature

1 On the Mail Center menu, click Set up Signatures.

2 In the Set up Signatures window, select the default signature (it is identified with a check mark) and click Default 
On/Off.

             Related Topics   –   E-mail  



 To add extra flair to your e-mail

1 Sign on to America Online.

2 Click Write.

3 On the Write Mail window, click Mail Extras.

             Related Topics   –   E-mail  
             Related Topics   –   Signatures  



 To search for information online

1 Sign on to America Online.

2 Type the word or words that describe the information you’re looking for in the text entry box on the toolbar. 

3 Click Search.

             Related Topics   –   Favorite Places  



 To switch screen names without signing off

1 On the Sign Off menu, click Switch Screen Name.

2 Select the screen name you want to switch to, and click Switch.

Notes

· This feature is not available if you are    signed on as a Guest. 

· Colored envelopes indicate which screen names have new mail waiting.



 To set up a cable modem location

1 On the Sign On screen, click Setup.

2 On the AOL Setup screen, click Expert Setup.

3 On the Locations tab in the Connection Setup window, click Add Location.

4 In the Name box, change the default name for the new location to Cable Modem Location.

5 Select the Add a custom connection (for example, TCP/IP) option and click Next.

6 In the Name box in the Add Number (Connection) window, change the default name for the new connection to 
Cable Modem Connection.

7 Select Cable Modem from the Automatic Connection Script list.

8 Click OK.

             Related Topics   –   Setup  
             Related Topics   –   Broadband Connections  



 To set up a Digital Subscriber Line (DSL) location

1 On the Sign On screen, click Setup.

2 On the AOL Setup screen, click Expert Setup.

3 On the Locations tab in the Connection Setup window, click Add Location.

4 In the Name box, change the default name for the new location to DSL Location.

5 Select the Add a custom connection (for example, TCP/IP) option and click Next.

6 In the Name box in the Add Number (Connection) window, change the default name for the new connection to 
DSL Connection.

7 Select DSL (Digital Subscriber Line) from the Automatic Connection Script list.

8 Click OK.

             Related Topics   –   Setup  
             Related Topics   –   Broadband Connections  



 To connect via cable modem

1 Connect to your cable modem provider as usual.

2 On the Sign On screen, select your cable modem location from the Select Location list.

3 Click Sign On.

             Related Topics   –   Setup  
             Related Topics   –   Broadband Connections  



 To connect via DSL

1 On the Sign On screen, select your DSL location from the Select Location list.

2 Click Sign On.

             Related Topics   –   Setup  
             Related Topics   –   Broadband Connections  



 To select another browser as your default browser

1 Start the browser you want to be the default browser.    A dialog box will appear, asking if you want that browser to 
be the default browser.

2 Click Yes.

Notes

· If the dialog box asking if you want to make that browser the default does not appear, check your help file for the 
browser, or the manufacturer’s web site for further information.

             Related Topics   –   Browser  
             Related Topics   –   Preferences  



 To reset mail and newsgroup associations

1 On the Windows taskbar, click Start, point to Settings and then click Control Panels.

2 In the Control Panel window, double-click Internet Options.

3 In the Internet Properties window, click the Programs tab.

4 Select the E-mail program you want to use from the E-mail list.

5 Select the newsreader program you want to use from the Newsgroups list.

6 Click OK.

             Related Topics   –   Preferences  



 To set Auto Start preference

1 On the Windows taskbar, right-click the  icon and select Auto Start Options from the menu that appears.

2 In the Auto Start AOL window, select your preference for starting AOL when an Internet connection is established.

3 Click OK.

             Related Topics   –   Preferences  



What is the Primary Master Screen Name?

The Primary Master Screen Name is the first screen name you selected when you created your America Online 
account.    It cannot be deleted or changed.



 To set up an ISP location

1 On the Sign On screen, click Setup.

2 On the AOL Setup screen, select the Create a location for use with new access phone numbers or an ISP 
option and click Next. 

3 In the Add Location window, type a name for the location (for example, Home – via ISP).

4 Select Add a custom connection (for example TCP/IP) and click Next. A TCP/IP location will be created.

             Related Topics   –   Setup  



  To connect via an ISP

1 Connect to your Internet Service Provider as usual.

2 Start America Online.

3 On the Sign On screen, select your Home   –   via ISP   location from the Select Location: list.

4 Click Sign On. 

             Related Topics   –   Setup  



 If your DSL connection does not complete

1 Make sure your DSL modem or card is connected to your phone line.

2 Make sure the DSL modem is plugged into an outlet.

             Related Topics   –   Setup  




